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Instrumentación Virtual con LabVIEW

Objetivos del Curso
• Comprender los componentes de un instrumento virtual
• Introducir LabVIEW y las funciones comunes de LabVIEW
• Construir una aplicación simple de adquisición de datos
• Crear una subrutina en LabVIEW
• Trabajar con Arreglos, Clusters y Estructuras
• Aprender sobre impresiones y características de 

documentación
• Desarrollo en arquitecturas de programación.
• Publicar VIs en el navegador  
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Sección I

• Términos de LabVIEW 
• Componentes de aplicación de LabVIEW
• Herramientas de programación de LabVIEW 
• Crear una aplicación en LabVIEW

Panel frontal
• Controles = entradas
• Indicadores = salidas

Diagrama de bloque
• Programa de acompañamiento 

para el panel frontal
• Componentes “cableados”  

entre si

Programas de LabVIEW se llaman instrumentos virtuales (VIs)
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Panel frontal de VI
Barra de herramientas
del panel frontal

Leyenda del 
gráfico

Control
Booleano

Gráfico de
Forma de onda

Icono

Leyenda de
La grafica

Leyenda de 
la escala

VI Diagrama  de bloque

Cableado
de
datos

Terminal 
grafica

SubVI

Estructura
While loop

Barra de
Herramientas
Del diagrama de 
Bloque

Funcion de 
dividir

Constante
numerico

Funcion de 
tiempo

Terminal de control
booleano
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VIs Expreso, VIs y Funciones
• VIs Expreso: VIs interactivos con pagina de dialogo 

configurable
• VIs estándar: VIs modulares y personalizables mediante 

cableado
• Funciones: Elementos fundamentales de operación de

LabVIEW; no hay panel frontal o diagrama de bloque

VI VI ExpresoExpreso VI VI EstandarEstandar

FuncionFuncion

Paleta de controles y funciones

Paletas de control
(Ventana del panel frontal)

Paleta de funciones
(Ventana de diagrama de bloque)
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Herramienta de operación

Herramienta de posicionamiento 

y redimensión

Herramienta de etiquetado

Herramienta de cableado

Herramienta de menú (atajo)

• Paleta flotante
• Utilizado para operar y modificar 

objetos en el panel frontal y en el 
diagrama de bloques.

Herramienta de desplazamiento

Herramienta de punto de paro

Herramienta de prueba

Herramienta para copia de color

Herramienta para colorear

Paleta de Herramientas

Herramienta de selección automatica

Botón de ejecución (Run)

Botón de ejecución continua
(Continuous Run)
Cancelación de ejecución
(Abort Execution)
Botón de pausa/continuación

Configuración de textos
(Text Settings)
Alineamiento de objetos
(Align Objects)
Distribución de objetos
(Distribute Objects)
Reordenamiento

Redimensionamiento de objetos
de panel frontal (Resize Objects)

Botón de ejecución resaltada
(Highlight Execution)

Botón de entrada al ciclo
(Step Into)
Botón sobre (Step Over)

Botón de salida del ciclo
(Step Out)

Botones adicionales en 
el diagrama de la barra 
de herramientas

Barra de herramientas de Estado
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No No borreborre estaesta DiapositivaDiapositiva

Abra y Ejecute un Instrumento Virtual 
Buscador de Ejemplos
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Terminales
de

Control

Ventana de Diagrama de Bloques

Ventana de Panel Frontal

Terminales
de

Indicador

Creando un VI

Creando un VI – Diagrama de Bloques
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Consejos Para Conectar – Diagrama de Bloques
“Punto Caliente” de Cableado

Limpiando el CableadoUtilice la Ruta Automática 
del Cable

Haga Clic para Seleccionar los Cables

No Borrar Esta DiapositivaNo Borrar Esta Diapositiva
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• El diagrama de bloque se ejecuta 
dependiendo del flujo de los datos; 
el diagrama de bloques NO se 
ejecuta de izquierda a derecha

• El nodo se ejecuta cuando los 
datos están disponibles para 
TODOS los terminales de entrada.

• Los nodos suministran datos a 
todos los terminales de salida 
cuando termina.

Programando el Flujo de Datos

Opciones de Ayuda

Contexto de la Ayuda
• Ayuda en línea
• Congelar Ayuda
• Ayuda del Diagrama Simple/Complejo
• Ctrl + H

Referencias en Línea
• Todos los menús en línea
• Clic en las funciones del diagrama para tener acceso directo a 

la información en línea.



10

No Borrar Esta DiapositivaNo Borrar Esta Diapositiva

Ejercicio 1 – Convertir de °C a °F
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Técnicas para Eliminar Errores
• Encontrando los Errores

• Resaltar la Ejecución

• Herramienta de Prueba

Haga clic en el botón de “correr” que esta roto;
Aparece una ventana mostrando los errores

Haga clic en el botón de ejecución resaltada; el 
flujo de datos es animado utilizando burbujas. 
Los valores se despliegan en los cables.

Haga clic con el botón derecho sobre el cable para 
exhibir la ventana de prueba y así mostrar los 
datos mientras fluyen por el segmento de cable.

También puede seleccionar la herramienta de 
prueba desde la paleta de herramientas y hacer un 
clic en el cable.

Sección II – SubVIs

• Que es un subVI?
• Elaboración de un icono 

y un conector para un 
subVI

• Utilizando un VI como 
un subVI
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Nodos del Diagrama de Bloques

Icono                              Nodo Expandible Nodo Expandido 

• VI de Generador de Funciones
• El mismo VI, visto en tres maneras 

diferentes.
• El campo amarillo designa un VI Estándar.
• El campo azul designa un VI Expreso

SubVIs
• Un SubVI es un VI que puede ser utilizado dentro de 
otro VI

• Similar a una subrutina
• Ventajas

– Modular
– Fácil para eliminar errores
– No tiene que crear códigos
– Requiere menos memoria
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Icono y Conector

• Un icono representa un VI en otro 
diagrama de bloque

• El conector muestra terminales 
disponibles para  transferir datos

Icon

Connector

Terminals

SubVIs Sub VIsSub VIs
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Pasos para crear un SubVI

• Crear el icono
• Crear el conector
• Asignar terminales
• Salvar el VI
• Insertar el VI dentro del VI principal

Crear el Icono
• Haga click derecho sobre el icono en el 

diagrama de bloque o panel frontal
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Crear el Conector
Haga click derecho  sobre el icono (solamente en el panel frontal)

Asignar Terminales
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Salvar el VI

• Escoja un sitio o un fólder fácil de recordar
• Organizar por funcionalidad

-salvar los VIs similares en un mismo directorio (Ej. Utilidades 
matemáticas)

• Organizar por aplicación
– Salvar todos los VIs Usados para una Aplicación Especifica dentro de 

un directorio o un archivo de librería (Ej. Lab 1 – Frecuencia de 
respuesta)

• Archivo de librería (.llbs) combina todos los VIs en un solo archivo, ideal para 
transferir aplicaciones enteras a través de computadoras

Insertar el SubVI dentro de un VI Principal

Acceder  subVIs creados por el usuario
Funciones >> All Functions >> Seleccione 

un VI  o  
arrastre el icono hasta el diagrama deseado
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Tips para trabajar en LabVIEW
• Atajos desde el teclado

– <Ctrl-H> – Activa/Desactiva la Ventana de Ayuda
– <Ctrl-B> – Remueve todos los cables rotos del diagrama de bloques
– <Ctrl-E> – Cambiar entre el Panel Frontal y el Diagrama de Bloques
– <Ctrl-Z> – Deshacer cambios – Undo (también disponible en el menu 

de edición)
• Herramientas » Opciones… – Establecer Preferencias en 

LabVIEW
• Propiedades del VI – Configurar la Apariencia del VI, 

Documentación, etc.

Sección III – Adquisición de Datos

• Datos de adquisición (DAQ en ingles) 
básicos

• Conectando Señales
• Aplicación simple con DAQ

Computadora

Dispositivo DAQ

Bloque de Terminales

Cable

Sensores
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Adquisición de Datos en LabVIEW

NI-DAQ Tradicional
VIs específicos para 
realizar:
• Entrada Análoga
• Salida Análoga 
• I/O (entrada/salida) 

Digital
• Operaciones de conteo

NI-DAQmx
Controlador (Driver) de 
siguiente generación: 
• VIs para ejecutar una 
tarea
• Un serie de VIs para 
todos los tipos de 
mediciones

DAQ – Adquisición De Datos

Adquisición de temperatura utilizando el Asistente de DAQ 
(DAQ Assistant)
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Terminología De la Adquisición De Datos

• Resolución – Determina cuantos diferentes cambios de voltajes 
pueden ser medidos
– Resolución mas grande Una representacion mas exacta de la 

señal

• Rango – Voltajes mínimos y máximos
– Rango mas pequeño Una representación mas precisa de la 

señal

• Gain (ganancia) – Amplifica o atenúa la señal para un mejor 
ajuste del rango

No Borrar esta DiapositivaNo Borrar esta Diapositiva
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Conexiones de Hardware

BNC-2120

SCB-68

NI-ELVIS

SC-2075

Ejercicio 2 – Adquisición de Datos Simples
Complete el VI de conversión de C a F (Conversion C a 
F.vi), y después cree el VI Termómetro (Thermometer.vi).
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No No BorrarBorrar estaesta DiapositivaDiapositiva

Sección IV – Ciclos y Gráficas

• For Loop (Ciclo Para)
• While Loop (Ciclo Mientras) 
• Gráficas
• Multiplots
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Ciclos
• Ciclo Mientras

– Tiene una Terminal de Iteración
– Siempre corre al menos una vez
– Corre de acuerdo a la  Terminal 

Condicionante

• Ciclos Para
– Tiene una Terminal de Iteración
– Corre de acuerdo a la  entrada 

N de la Terminal de Conteo

Ciclos (cont.)
1. Seleccionar el ciclo 2. Encerrar código que va a ser repetido

3. Arrastrar nodos adicionales y luego cablear
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Gráficas

Gráfica de forma de onda –
indicador númerico especial  
que puede mostrar una 
historia de valores

Controles >> Indicadores de 
Gráficas >>  Gráfica de 
forma de onda

Cableando Datos a las Gráficas
Grafica de diagrama simple Grafica de diagrama múltiple
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Ejercicio 3 – Usando ciclos
Estudiantes construyen el VI  Ejemplo de Ciclo.vi.

Sección V – Arreglos & Manejo de Archivo (File I/O)
• Construir arreglos manualmente
• Dejar que LabVIEW construya arreglos 

automáticamente
• Escribir a un archivo de hoja de cálculo (spreadsheet)
• Leer desde un archivo de hoja de cálculo (spreadsheet)
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Agregando un Arreglo al Panel Frontal
Desde la sub-paleta de Controls >> All Controls
>> Array and Cluster, seleccione el Array Shell

Colóquelo en la pantalla.

Agregando un Arreglo (cont.)
Situé el objeto de datos dentro del shell (Ej. Control Numérico)
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Creando un Arreglo con un Ciclo

• Los ciclos acumulan arreglos en sus limites.

Creando Arreglos Bidimensionales (2D)
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Manejo de Archivos (File I/O)
Manejo de Archivos – transferir datos a y desde archivos
- Los Archivos pueden ser binarios, texto u hojas de calculo
- Escritura/Lectura de Archivos de Medición de LabVIEW
(LabVIEW Measurements – *.lvm)

EscrituraEscritura en en ArchivoArchivo LVMLVM LecturaLectura de un de un ArchivoArchivo LVM LVM 

Escritura de Archivos de Medición LabVIEW
(LabVIEW Measurement)
• Incluye las funciones de apertura, escritura, cierre y manejo de errores
• Maneja el formateo de cadenas de caracteres (strings) ya sea con 

delimitación por medio de tab o de coma
• La función de concatenar señales es usada para combinar datos en

datos de tipo dinámico
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Ejercicio 4 – Analizando e Introduciendo Datos
Los Estudiantes construyen el VI Logger de Temperatura.vi

Sección VI – Funciones de Arreglos y Graficos

• Funciones Básicas de los Arreglos
• Uso de gráficos
• Crear Diagramas Múltiples con Gráficos
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Funciones de los Arreglos – Lo Basico
Functions >> All Functions >> ArrayFunctions >> All Functions >> Array

Funciones de los Arreglos – Construcción de un Arreglo
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Gráficos
• Seleccionados desde la Paleta de Controles del Menu

Controls >> All Controls >> Graphs

Grafico de Forma de Onda Grafico de Forma de Onda 
((WaveformWaveform GraphGraph)) –– Grafica un Grafica un 
arreglo de numeros en contra de sus arreglo de numeros en contra de sus 
indicesindices
Grafico XY Expreso (Express XY Grafico XY Expreso (Express XY 
GraphGraph)) –– Grafica un array en contra Grafica un array en contra 
de otrode otro
Grafico de Forma de Onda Digital Grafico de Forma de Onda Digital 
((DigitalDigital WaveformWaveform GraphGraph)) ––
Grafica bits de datos binariosGrafica bits de datos binarios

No borrar esta DiapositivaNo borrar esta Diapositiva
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Gráficos

Haga Clic Derecho en la grafica y seleccione Properties
(propiedades) para poder personalizar interactivamente

Ejercicio 5 – Usando Graficos de Forma de Onda           
(Waveform )
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Sección VII – Cadenas de Caracteres, Clusters, 
& Manejo de Errores

• Cadenas de caracteres
• Creando Clusters
• Funciones de los Clusters
• I/O Error

Cadenas de caracteres
• Una cadena es una secuencia de caracteres desplegables o 

no desplegables (ASCII)
• Tienen muchos usos – despliegue de mensajes, Control de 

instrumentos, Archivos de entrada y Salida (I/O)
• El controlador/indicador de cadenas se encuentra en  

Controls »Text Control o Text Indicator



33

Clusters
• Estructura de Datos que agrupa datos juntos.
• Los Datos pueden ser de diferentes tipos.
• Semejante a una estructura (struct) en C++
• Los elementos deben de ser ya sea, todos 
Controles o todos Indicadores

• Se puede considerar como un conjunto de 
alambres agrupados en un cable.

Creando un Cluster
1. Seleccionar la pre-forma (shell) del Cluster

Controls >> All Controls >> Array & Cluster

2. Colocar Objetos dentro de la pre-forma (shell)
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Funciones del Cluster
• Están ubicadas en la subpaleta de Cluster de la 

paleta Functions>>All functions.
• También puede ser accesada haciendo clic con el 

botón derecho del mouse en la terminal del Grupo.

Bundle
(Agrupar)

(Las etiquetas de la 
terminal  reflejan los 
tipos de datos)

Bundle by name
(Agrupar por nombre)

Funciones del Cluster

Unbundled
(separar)

Unbundled by name
(separar por nombre)

Ejemplo de un 
Cluster separado 
(Unbundled Cluster)
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Errores de Cluster
• Los Errores de Cluster contienen la siguiente información:

– Booleano (Boolean) Para  reportar si surgió algún error
– Enteros (Integer) Para reportar errores específicos de códigos
– Cadena (String) Para brindar información acerca del error

Técnicas de Manejo de Errores

• La información de un Error es transmitida de un subVI al siguiente
• Si un Error ocurre en un subVI, todos los subVI subsecuentes no 

serán ejecutados de la manera usual
• Los errores de Cluster contienen todas las condiciones del Error
• Manejo automático de Errores

Errores de Cluster



36

Sección VIII – Estructuras de Caso y Secuenciales, 
Nodos de Formula

Estructuras Caso
• En la subpaleta de estructura  de las paleta de funciones.
• Encerrar los nodos o arrastrarlos hacia adentro de la 

estructura.
• Colocados como un juego de cartas (naipes), solo un caso 

es visible a la vez.

Functions >> Execution control
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Ejercicio 6 – Errores de Cluster y su Manejo

Estructuras de Secuencia
• En la subpaleta de control de ejecución (Execution 

Control) de la paleta de funciones.
• Ejecuta diagramas secuencialmente.
• Presionar botón derecho del mouse para agregar un 

nuevo cuadro (frame).
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Nodos de Formula
• En la subpaleta de Estructuras (Structures). 
• Implementa ecuaciones complicadas.
• Variables creadas en los márgenes 
• Nombres de variables son sensibles (mayúsculas/minúsculas)
• Cada declaración debe de terminar con un punto y coma(;)
• La ventana de ayuda muestra las funciones disponibles.

Note el Punto y coma

Sección IX – Documentacion e Impresion

• Imprimir desde el Menú de Archivo (File Menu) hacia: 
la Impresora, HTML, Archivos de Texto. 

• Imprimir programáticamente Graficas o Imágenes del 
Panel Frontal

• Documentar los VIs en VI Properties » Documentation 
Dialog

• Agregar Comentarios usando etiquetas libres dentro 
del panel frontal y diagramas de bloques.
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Impresión
• File » Print… Da muchas opciones de impresion

– Seleccione la Impresión del Icono, el Panel Frotal, el Diagrama de  
Bloques, La Jerarquía del VI, SubVIs Incluidos, Historia del VI

• Print Panel.vi (Programaticamente imprime un Panel Frontal) 
– Functions » All Functions » Application Control

• Generar e Imprimir Reportes (Functions » Output » Report)

Documentando VIs

• VI Properties » Documentation
– Provee una Descripción e Información de Ayuda para el VI

• VI Properties » Revision History
– Monitorea cambios entre diferentes Versiones de un VI

• Individual Controls » Description and Tip…
– Haga clic con el botón derecho del mouse para proveer una 

descripción y ayuda (Description and Tip Strip)
• Utilice la herramienta de etiquetado (Labeling Tool) para 

documentar paneles frontales y diagramas de bloques
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Sección X – Arquitectura Básica de Programación

• Arquitectura VI de un simple
• Arquitectura de un VI General
• Arquitectura de maquina de estado

Arquitectura de un VI simple

• VI funcional que produce resultados al ser ejectado
– No tiene opciones para “comienzo” o “fin” 
– Adecuado: para pruebas de laboratorio, cálculos

• Ejemplo: Convertir C a F.vi
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Arquitectura de un VI General

• Tres pasos principales 
– Inicio
– Aplicación principal
– Cierre (shutdown)

Arquitectura de Maquina de Estado
• Ventajas 

– Puede ir de cualquier estado a otro
– Fácil de modificar y depurar

• Desventajas 
– Se pierden eventos si dos ocurren al 

mismo tiempo
Pasos:
0: Inicio (Startup)
1: Ocio (Idle)
2: Evento 1
3: Evento 2
4: Cierre (Shutdown)
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Ejercicio 7 – Simple Maquina de Estado

No Borrar Esta FilminaNo Borrar Esta Filmina
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Sección XI – Panel Frontal Remoto

• Observar y Controlar Paneles Frontales de LabVIEW
desde un Navegador en la Web

• No Requiere Programación
• Usuarios en lugares Remotos pueden ver en Tiempo 
Real las Actualizaciones del Panel Frontal

• Múltiples clientes pueden Observar el Panel Frontal 
Simultáneamente

• Solo un Cliente Puede Controlar el Panel Frontal a la 
vez

Herramienta para la Publicación de un Panel Remoto
•Tools » Web Publishing Tool…

•Clic Salvar a Disco y el 
VI es embebido a un 
archivo HTML

•Después que el 
archivo a sido grabado, 
puede ser reabierto y 
personalizado en 
cualquier editor HTML
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Panel Frontal Remoto - Recursos
• NI Developer Zone

(zone.ni.com)
– Busque Remote Front

Panel
– Tutóriales e Instrucciones 

están disponibles para 
descargar (download).

– Información para poder 
Incorporar una cámara 
Web en aplicaciones con 
panel remoto.

Sección XII – Temas Adicionales

• Nodo de Propiedad
• Variables Locales
• Variables Globales
• DataSocket
• Archivos Binarios I/O



45

Qué hago Ahora?

• Ejemplos de Programas (Help» Find Examples…)
• LabVIEW Edición de Estudiantes 
(www.ni.com/labviewse)

• Recursos Web (ni.com)
– Zona de Desarrollo NI (zone.ni.com)
– Notas de Aplicaciones 
– grupo de noticias labview (www.info-labview.org/)
– Instrument Driver Library (www.ni.com/idnet)


